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5.0 INTRODUCTION 
This chapter contains instructions on how to use the given software as it relates to the technologies 
deployed by this unit (e.g., intelligent compaction, paver mounted thermal profiling, etc.).  Instructions 
for the following software are currently contained within this chapter:   

• Veta (Intelligent Construction Data Management Software),  
• MnCon (coordinate conversions) and  
• Trimble Connect (file sharing). 
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5.1 VETA (INTELLIGENT CONSTRUCTION DATA 
MANAGEMENT SOFTWARE) 

Veta is a standardized intelligent construction data management (ICDM) software that stores, maps 
and analyzes geospatial data resulting from intelligent compaction, thermal profiling and spot test data 
(e.g., density, moisture).  This software can perform standardized data processing, analysis and 
reporting to provide Project summary results quickly in the field from various intelligent compaction 
and thermal profiling manufacturers.  In particular, the software can provide statistics, histograms, 
correlations for these measurements, document coverage area and evaluate the uniformity of 
compaction and surface temperature measurements as part of the project quality control operations.   

5.1.1 Sample Veta Projects and Data 
Sample files for different manufacturers are downloaded during the installation process of Veta.  These 
samples files are installed to the following folders depending on the OS: 

• Windows XP - C:\Documents and Settings\All Users\Shared Documents\Veta 4 Samples 
• Windows 7+ - C:\Users\Public\Public Documents\Veta 4 Samples 

Sample projects and data can also be downloaded from the Advanced Materials and Technology 
Website at:  http://www.dot.state.mn.us/materials/amt/veta.html.   

5.1.2 Download and Open Veta Software 
The Veta software can be downloaded from the Advanced Materials and Technology Website at:  
http://www.dot.state.mn.us/materials/amt/veta.html. 

5.1.3 Creation of New Veta Project 
Select Import Data to add data to a new project. 

 

Navigate to and select data file(s) to be imported.  Press Left mouse button to select desired file 
to import.  To import multiple files, hold down the Ctrl Key and simultaneously select the left mouse 
button on the desired files to import. 

Select Open at the bottom of the window to complete the initial data import process. 

http://www.dot.state.mn.us/materials/amt/veta.html
http://www.dot.state.mn.us/materials/amt/veta.html
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Select the Coordinate System and location unit used by the technology.  Please note that intelligent 
compaction (IC) systems must be setup to collect data using the Minnesota county coordinate 
system.  However, most paver mounted thermal profiling (PMTP) systems are collecting in GPS, 
as MnDOT currently does not have any coordinate requirements for these datasets. 

Select the Minnesota County Zone that the data was collected in and then select Next.  Please note 
that MnDOT uses the County Coordinate system throughout the state and on all designs. 

 

Review the Import results to ensure that all files were successfully imported into Veta.  The word 
“Success” is listed behind files names that were successfully imported into Veta.  Select Next to 
continue to next screen. 
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“No Valid Data Found” is listed behind the file name for cases of corrupt files or where no 
coordinates were collected.  Re-import these files again to ensure that there was not an error in the 
import process.  Troubleshooting may be needed to determine why the files do not import. 
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Ensure check box is select by Save Project and Select Finish to save project. 
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Navigate to the desired file folder location to save the file and type in the required standardized 
Veta project name into the text box by File Name.  Select Save.  The standardized naming 
convention requirements can be found at: 

(2016) Quality Management – Paver Mounted Thermal Profile Method (S-xx.3.H | Table 2016-6 
(PMTP)) 

(2016) Quality Management Special – Intelligent Compaction Method (S-xx.3.J | Table 2016-9 (IC)) 

 

5.1.4 Close Project 
The Veta project can be closed by either selecting the “×” in the top right corner of the software, or 
be selecting Project from the menus toolbar and selecting close project. 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 7 | P a g e  

 

 

5.1.5 Opening an Existing Project 
Select Open Project to navigate and open an existing project, or select the project name under Recent 
Projects. 

 

5.1.6 Set Displayed Coordinate System 
The coordinate system that is displayed on the map and used for spot test locations can be converted 
to County Coordinates for PMTP systems that use a coordinate system other than County 
Coordinates.  Select the Project icon in the menus toolbar and select Properties from the dropdown 
menu. 
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Within the Project Properties dialog choose the dropdown and select Minnesota Counties as the 
coordinate system.  Select the desired County from the Minnesota County Zone dropdown menu. 

 

5.1.7 Quick Access Toolbar 
The quick access toolbar allows the user to use shortcuts to perform the following: 

SAVE 
Select the disk icon with the left mouse button in the quick access toolbar to save projects. 
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SNAPSHOT 
Select the camera icon with the left mouse button in the quick access toolbar to take a screen shot 
of the entire Veta screen.  The image is stored in a virtual clipboard that cannot be seen until the user 
pastes the image into the desired software platform (e.g., Microsoft Word, Excel, PowerPoint, etc.). 

 

OPTIONS 
Select the tools icon with the left mouse button in the quick access toolbar to change the units of 
measure displayed and used in Veta (i.e., Meters, Feet, US Survey Feet) and to change the default 
folder location for saving Veta projects. 

 

HELP 
Select the help icon with the left mouse button in the quick access toolbar to save logs (i.e., save a 
log of what occurred during a software crash), User’s Guide, Release Notes, Support information and 
“About” the software (i.e., the software version and copyright information). 

 

5.1.8 Add File (Data and/or Alignment) 
The add file feature allows the user to add additional data (i.e., data files) to the Veta project and/or 
one or more alignment files. 

ADD DATA FILE(S) 
Select the Add File icon in the menus toolbar and select Add data from the dropdown menu.   

 

Navigate to and select data file(s) to be imported.  Press Left mouse button to select desired file 
to import.  To import multiple files, hold down the Ctrl Key and simultaneously select the left mouse 
button on the desired files to import. 
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Select Open at the bottom of the window to complete the initial data import process. 

 

Review the Import results to ensure that all files were successfully imported into Veta.  The word 
“Success” is listed behind files names that were successfully imported into Veta.  Select OK. 
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“No Valid Data Found” is listed behind the file name for cases of corrupt files or where no 
coordinates were collected.  Re-import these files again to ensure that there was not an error in the 
import process.  Troubleshooting may be needed to determine why the files do not import. 

ADD ALIGNMENT FILE(S) 
Select the Add File icon in the menus toolbar and select Add alignment from the dropdown menu.   

 

Navigate to and select alignment file(s) to be imported.  Press Left mouse button to select desired 
file to import.  To import multiple files, hold down the Ctrl Key and simultaneously select the left 
mouse button on the desired files to import. 

Select Open at the bottom of the window to complete the initial data import process.   
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Select Alignment from the menu toolbar and then select the alignment file name in the left pane 
to confirm that the alignment file correctly imported.  Individual layers of the design can also be 
viewed independently by selecting the layers listed below the alignment file name. 

 

5.1.9 Viewer 
The Viewer allows the user to view the measurements collected by the given technology on a larger 
screen.  For instance, the user can view pass count, speed, frequency, amplitude, surface temperature, 
and CMV (stiffness) measurements for the IC technology and paver speed and mat surface 
temperature for the PMTP technology.  These measurements can also be viewed in the following 
Menus:  Editor, Alignment, Filters and Spot Tests. 

Select Viewer from the menu toolbar to view maps of the data. 

 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 13 | P a g e  

 

5.1.10 Panning the Map 
Pan (move) the maps being viewed by selecting and holding the left mouse button while 
dragging the map to the desired location on the screen.  Release the left mouse button to stop 
panning the map. 

5.1.11 Command Toolbar 

RULER 
The ruler allows the user to measure distances of features on the displayed map.  Select the ruler icon 
in the command toolbar.  Press and hold left mouse button at the starting location of 
measurement and drag mouse to the ending location.  Release left mouse button when the cursor 
is at the ending measurement location.  A dialogue box containing the linear length will then appear 
on the screen. 

 

 

 

ZOOM IN AND ZOOM OUT 
The zoom in and zoom out buttons allow the user to change the scale that the measurements are 
currently displayed.  The zoom in button allows the user to increase the scale that the data is currently 
displayed on the map.  Conversely, the zoom out button allows the user to decrease the scale that the 
data is currently displayed on the map. 

Starting location 
of measurement 

Ending location 
of measurement 

Linear length of measurement in English and Metric units. 
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Select the Zoom In icon from the command menu to increase the scale (zoom into) the data that 
is currently displayed. 

 

 

Select the Zoom Out icon from the command menu to decrease the scale (zoom out) the data that 
is currently displayed. 

 

Scale of displayed data 
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ZOOM TO SELECTABLE AREA 
The zoom to selectable area icon allows the user to zoom in (i.e., decrease the scale) to a given area of 
data by drawing a box around the region.  Select the Zoom to Selectable Area icon in the command 
toolbar and press and hold left mouse button dragging the mouse to select the desired region.  
Release the left mouse button after the desired area is drawn.  The display will then zoom into the 
selected area. 

 

 

Scale of displayed data 

Area selected using “zoom to selectable area” icon. 
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GO BACK TO PERVIOUS ZOOM AREA 
The “Go back to Previous Zoom Area” icon in the command toolbar allows the user to update the 
displayed map to the previously displayed map prior to zooming to a selectable area. 

 

VIEW MAP CENTER 
The View Map Center icon allows the user to view the location of the center of the map currently 
displayed in Veta in one of the following platforms:  Bing, Google Earth or Google Maps.  Please 
note that the IC and PMTP data is not mapped in these platforms. 

 

Display of selected area of data. 
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VIEW 

 

Select View in the command toolbar to toggle on and off the following: 

Hide Map – Hide Map allows the user to turn off the background maps when viewing IC or PMTP 
measurements.   

Road Map – Road Map allows the user to turn on “Bing Maps” as a background layer when viewing 
IC or PMTP measurements.  Please note that the accuracy and precision in Bing Maps is limited to 
the satellite imagery and the quality of the datum tie.  

 

View of Map Center in Google Earth 
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Aerial Map – Aerial Map allows the user to turn on “Bing Maps – Satellite Imagery” as a background 
layer when viewing intelligent compaction or thermal profiling measurements.  Please note that the 
accuracy and precision in Bing Maps is limited to the satellite imagery and the quality of the datum tie. 

 

 

Legend – The Legend allows the user to toggle on or off the display of the legend.  The legend 
explains the colors and values displayed by the maps.  Section 5.1.12 describes how to edit (customize) 
the legend (i.e., modify values, colors, increments, etc.).   
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Filtered data only – The Filtered Data Only feature allows the user to toggle on and off the viewing 
of data that has been removed through the operation and/or data filters.  Data removed by filters is 
colored in ‘gray’ to differentiate it from the remaining data. 

Deselect (Uncheck) the Filtered data only with left mouse button from the View dropdown 
menu to view the data that was filtered out using operation and/or data filters (shown in gray) along 
with the filtered data. 

 

 

 

 

 

Data removed using operation/data filters. 
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Select (check) Filtered data only with the left mouse button from View dropdown menu to only 
view data selected through the operation and/or data filter(s). 

 

 

DATA 
The Data dropdown menu allows the user to toggle between viewing different measurements collected 
by the intelligent compaction or thermal profiling systems (e.g., pass count, speed, frequency, 
amplitude, surface temperature, CMV, paver speed).  The check to the left of the measurement 
indicates which parameter is currently selected and mapped.  The following images show the example 
for viewing pass count. 

 

Select Pass Count with left mouse button to view Pass Count measurements. 
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ALIGNMENT 
Alignment allows the user to turn on or off the alignment layer from the background.   

Select Alignment from the dropdown menu using the left mouse button to toggle on and off the 
alignment file by selecting or deselecting the given alignment file name. 

 

View without the Alignment File 
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5.1.12 Customize Legend 
The user can edit the legend (change the scale interval, scale colors and background map color) for 
the intelligent compaction or thermal profiling measurements.  The following is an example of how 
to change surface temperature measurements for the thermal profiling system. 

Select the Data dropdown from the command menu and select temperature. 

 

View with the Alignment File 
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Right click on the legend and select customize to change the color palette for the surface 
temperature readings.  Use the following color pallet for surface temperature measurements for the 
thermal profiling system.  Darker background (e.g., black, DimGray) colors are recommended as these 
colors provide contrast assisting with viewing of the surface temperature measurements.  Select the 
Add button with the left mouse button to add additional temperature levels.  To delete a given 
temperature select the temperature box with the left mouse button and then select Delete.  Select 
OK to save changes to color palette. 

Select the given temperature value with the left mouse button to edit the value shown.  Use the 
dropdown to the right of the color names to change the color for the given range. 

 

5.1.13 Editor 
The editor menu allows the user to view the locations of data with respect to the given file name, to 
delete files and to view file properties (size, modification date, time imported, number of rows of data 
found in the file, number of invalid coordinates, number of rows of data imported, duplicate records 
and number of rows of data added to the Veta project). 
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VIEW DATA ASSOCIATED WITH FILE AND FILE PROPERTIES 
Select the file name with the left mouse button to view the map of the data associated with the 
given file selected and the file properties.  The file properties are listed on the left pane and the map 
of the intelligent compaction or thermal measurements is presented in the right pane.   

 

REMOVE (DELETE) FILE 
Select the right mouse button on the name of the file to be removed from the Veta project.  Select 
remove file.  A popup window will appear to confirm the removal of the selected file.  Select delete 
to remove the file or cancel to stop removal of the file. 

Right Pane:  Map 

File Selected 

Left Pane:  File Properties 
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COPY TABLE OF IMPORTED FILES 
Select anywhere on the table with the right mouse button and select copy to clipboard, or copy 
without column names, to copy the table of imported files to the clipboard.  The table can then be 
pasted into another software package (e.g., Microsoft Word, Microsoft Excel, etc.) as desired. 
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5.1.14 Alignment 
The Alignment menu allows the user to view and relabel, if needed, the individual layers within the 
alignment file.  It is recommended that this feature is used to relabel the complex shape files to assist 
with the correct selection of shapes within the location filter.  Complex shapes are polygons (typically 
polygon outlines of each traffic and required auxiliary lane) that are used to trim (exclude) data that is 
located outside of the required areas.  Complex shapes are currently only used with intelligent 
compaction data and not with the thermal profiling data.  Thermal profiling data is sub-meter 
accuracy, and therefore, cannot be trimmed correctly using complex shapes. 

 

RE-LABELING OF COMPLEX SHAPES 
The complex shapes are typically labeled (by default):  UDEFA, UDEFB, UDEFC, …, etc.  This 
default labeling schema makes it difficult to remember which complex shape is for a given centerline 
offset (production/compaction area).   
 
View Line-work for Entire Alignment File 
Selection of the layers in the left pane allows the user to view the given layer.  For instance, select 
with the left mouse button the alignment file name, in the left pane, to view the entire alignment. 

 

Alignment 
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View and Re-Label Complex Shape Layers 

Select each complex shape to visually determine which centerline offsets that the given shape 
represents.  Centerline offset layer lines can be viewed by expanding each layer by selecting the “+” 
box with the left mouse button.  Label each complex shape using the centerline offset naming 
convention by selecting the complex shape name with the right mouse button (see example 
below).   

See (2016) Quality Management Special – Intelligent Compaction Method (Table 2016-7 (IC) for 
required standardized centerline offset labeling. 

     

Default Complex Shapes Labeling Re-Labeled Complex Shapes 

5.1.15 Create Filter Combinations for Each Lot 
Creation of filters allows the user to organize the data for mapping and analyses.  Such as, by 
production/compaction day, location, lift, lane, roller, paver, etc.  See the following tables for the 
required standardized naming conventions. 

(2016) Quality Management Special – Intelligent Compaction (IC) Method (Table 2016-10 [IC]) 

(2016) Quality Management – Paver Mounted Thermal Profile Method (Table 2016-7 [PMTP]) 

FILTER GROUP MANAGER 
The Filter Group Manager will assist with creation of the required standardized naming convention 
for each filter group. 

Select Filters from the menu toolbar.   

 

Select Create from the menu toolbar and select Create Filter Group.   
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Select MnDOT from the Filter Group name template dropdown list. 

 

Project Information 

Complete the required project information.  Completion of the Project Information allows Veta to 
generate the needed Filter Group names.   
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Route System – Select the type of system from the dropdown menu. 

 

Route Number – Type the route number into the text box (e.g., 79). 

 

Custom Calibration Zones – This feature is used for cases where more than one site calibration 
zone is needed within the project limits.  Enter the name of the sites into the text box.  Ensure that 
these names are consistent with the lot naming convention used in the technology’s data acquisition 

The Centerline 
Offsets and Lifts are 

auto-generated / 
created by Veta using 

the project 
information entered 

by the user. 
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system (e.g., N, S, E, W).  Use commas, without spaces, to add more than one site calibration 
zone. 

 

Material – Select the material type from the dropdown menu that the technology is being used. 

 

Number of Lifts – Enter the total number of lifts for where the technology is being used. 

 

Centerline Offsets – Select all of the centerline offsets for where the technology is being used.   

 

Custom Centerline Offsets – Use the Custom Centerline Offset text box to list offsets that are 
not included in the check box list.  Use a comma, without spaces, to add more than one custom 
offset (e.g., 6R-18R,18R-30R). 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 31 | P a g e  

 

 

Direction of Travel – For divided highways, select the Direction of Travel for where the 
technology is used.  This parameter is not needed on projects that are not undivided.   

 

Daily (Create Filter Group for Each Lot) 

The Daily Pane allows the user to create the Filter Group names for each lot.  Complete the following 
information for each lot. 
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Lot Number – Type the lot number in the text box (e.g., 01, 02, etc.). 

 

Collection Date – Select the date that the technology was used for the given lot using the provided 
calendar (e.g., paving date, compaction date). 
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Lot Name – Select the name of the lot from the dropdown menu.  Review the project information 
(in the upper pane) for missing information if the desired lot is not listed. 

 

Add Filter – Select Add Filter to add the given lot.  Continue this process to create Filter Group 
Names for additional lots. 

 

OK – Select OK after creation of desired Filter Groups. 
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OPERATION FILTERS 
In the background, Veta has created a database containing all of the data that has been imported into 
the project.  Therefore, the user needs to use some criteria to separate (filter) the data for a given lot 
from the rest of the data.  The Operation Filter allows the user to select different parameters to filter 
the data by (e.g., imported file name, machine ID, design name, time, location, etc.).  Veta 
automatically creates the Operation Filter for each lot upon creation of the given Filter Group Name 
when using the MnDOT Filter Group Manager. 

Review Operation Filters 

Review the operation filter parameters for any needed changes. 

An asterisk will show next to the newly created Operation Filter names that have not yet been 
expanded for review. 

 

Verify that the Check box next to the operation filter name (in the left pane) is associated with the 
corresponding selected Filter Group Name.   

 

Imported File Name 

The imported file name allows the user to filter by the files that are imported into the Veta project.  
In some instances, more than one file may contain data for a given lot. 

Veta will attempt to automatically select file names with dates matching the date used in the 
filter group name for the given lot when creating Filter Groups using the MnDOT Filter Group 
Manager.  Label exported compaction files with the MMDDYY date format in the file name. 

Select or deselect file names, as needed, for the given lot. 
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Sensor Location (PMTP Method Only) 

The sensor location lists the sensor locations in which the thermal profiling measurements were 
collected.  For a scanning and photogrammetric systems, the measurements are gridded across the 
width of the paving area (see figure 5.1 below).  Sensor locations are number from 1 to N, left to right, 
in the direction of paving (i.e., sensor 1 reflects the left edge of the paver).  
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Figure 5.1 – Example gridding of thermal profiling data (photo courtesy of Moba Corporation). 

 

Select Sensor Location from the Operation filter in the upper left pane and ensure that all sensors 
are selected (checked) in the lower left pane.  It is required that thermal segregation is evaluated 
using 100 percent of the recorded data for each sublot to ensure uniformity in analyses (see reference 
for requirements below).   

(2016) Quality Management – Paver Mounted Thermal Profiling Method (S-xx.3.J.1.a) 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 37 | P a g e  

 

 

Machine ID 

The Machine ID represents the identification used for each IC system (roller) or PMTP system.   

Select Machine ID from the operation filter in the upper left pane and ensure that the correct 
Machine ID(s) are selected (checked) in the lower left pane.  All IC systems (per lot) must be 
selected for compaction projects; only one PMPT system (per lot) is selected for thermal 
projects.  The example below is for a compaction project, and therefore, all Machine IDs are selected. 
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Design Name (IC Method Only) 

The Design Name is used for select IC systems to define the lot where the rollers were compacting.   

Select Design Name from the operation filter in the upper left pane and ensure that the correct 
design name(s) are selected (checked) in the lower left pane for systems using this parameter.  Veta 
will automatically select the Design Name that is matching the lot designation included in the Filter 
Group Name when creating Filter Groups using the MnDOT Filter Group Manager. 
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Troubleshooting – If data appears to be missing, verify that all of the rollers (IC systems) were using 
the correct / same Design Name.  Multiple Design Names can be selected for instances where one or 
more rollers were using a different Design Name; however, there must not be an adjacent lot for the 
given day of paving.  An additional Operation Filter must be made for instances where there are 
adjacent lots on the same day of paving.  Each Operation Filter would use a different time filter and 
Design Name and would be selected for the given Filter Group.  Select Create and select Create 
Operation Filter from the dropdown menu to create additional operation filters.  Label the 
operations filters with the lot number followed by a hyphen and a numeric number is sequential order 
(e.g., 20-1, 20-2). 
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Time Filter 

The time filter allows the user to filter by a specific date or a time/date range.  Select Time Filter 
from the operation filter in the upper left pane and view the specific available time filters in the 
lower left pane for cases where the file is not used to sort by date. 
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Cold Edge & Ride Bracket Filter (PMTP Method Only) 

The Cold Edge & Ride Bracket Filter statistically removes the following surface temperature readings.  
Please note that it is important to remove these types of surface temperature readings as these 
measurements can significantly affect the thermal segregation analyses possibly causing improper 
thermal segregation classifications (i.e., categorizing a given sublot as moderate or severe when it 
otherwise would had been categorized as low severity). 

• Surface temperature measurements capturing brackets used for pavement smoothness that are 
located in the PMTP system measurement area.  Figure 5.2 illustrates an example of cooler, 
longitudinal surface temperature readings that were caused by brackets used to assist with 
pavement smoothness (see Figure 5.2). 
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FIGURE 5.2 – Example of cooler surface temperature measurements caused by brackets used for pavement 
smoothness. 

 

• Surface temperature measurements capturing an adjacent edge that is cooler than the mat 
currently being paved (e.g., echelon paving, shoulder, turn lanes, etc.).  Figure 5.3 illustrates 
cooler surface temperature measurements collected on the pavement edge due to echelon 
paving (part of the last gridded surface temperature reading contained the cooler mat of the 
adjacent lane). 

  

Brackets for pavement smoothness 
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FIGURE 5.3 – Example of cooler surface temperature measurements along pavement edge due to echelon paving. 

 

Select the Cold Edge & Ride Bracket Filter from the upper left pane and ensure that the Remove 
cold edges and ride brackets is selected in the lower left pane to statistically remove these types 
of surface temperature readings from future thermal segregation analyses.  Veta automatically selects 
this filter when creating Filter Groups using the MnDOT Filter Group Manager. 

Cooler, longitudinal surface temperature 
measurements from echelon paving. 
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Location Filter 

The location filter allows the user to select data based on a region defined by the user.  There are three 
types of location filters:  Custom, Copy from alignment drawing and Use a portion of an alignment 
drawing. 

Custom Location Filter 

The custom location filter allows the user to filter an area of data (trim the data) through custom 
creation of a polygon.   

Select Location from the operation filter in the upper left pane and then select Source from the 
lower left pane.   
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Select Custom from the resulting dialogue box.  Select OK. 

 

Select the right mouse button and select add location at desired locations to create customized 
filter area.  Select Apply Filter Group from the menu toolbar to update map (i.e., remove data outside 
of selected region/custom location filter).   
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Map prior to Applying Filter Group: 
Four (4) custom points added through 

location filter. 
Coordinates of four custom points. 
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Points can be moved by placing the cursor over the given point and selecting and holding the left 
mouse button while dragging this point to a different location. Points can also be removed by placing 
the cursor over the point selecting the left mouse button and selecting Remove Location.  

Copy from Alignment Drawing Location Filter 

The copy from an alignment drawing location filter allows the user to filter an area of data (trim the 
data) through the use of a complex shape of an alignment file.  (Complex shapes are alignment 
boundaries that are continuous and closed at each end.) 

Select Location from the operation filter in the upper left pane and then select Source from the 
lower left pane.   

Trimmed data after selecting Apply Filter Group 
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Select Copy from alignment drawing from the resulting dialogue box and select the desired 
alignment file, drawing and line from the dropdown menus.  Select OK.  Please note that the 
dropdown menus are not available (grayed out) when there is only one option to select from as this 
value is auto populated in the selection box. 

 

Select Apply Filter Group from the menu toolbar to update map (i.e., remove data outside of selected 
alignment drawing).   
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Map prior to Applying Location Filter: 
Alignment boundaries used to trim data. 

Coordinates of alignment drawing. 
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Use a Portion of an Alignment File Location Filter (Used for the IC Method) 

The use a portion of an alignment file location filter allows the user to filter an area of data (trim the 
data) through the use of a portion of a complex shape of an alignment file.  (Complex shapes are 
alignment boundaries that are continuous and closed at each end.) 

Select Location from the operation filter in the upper left pane and then select Source from the 
lower left pane.   

Trimmed data after selecting Apply Filter Group 
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Select Use a portion of an alignment drawing from the resulting dialogue box and select the 
desired alignment file, drawing and line from the dropdown menus.  Select OK.  Please note that 
the dropdown menus are not available (grayed out) when there is only one option to select from as 
this value is auto populated in the selection box. 

 

The user now enters four (4) coordinates to define the portion of the alignment drawing to use.  This 
can be completed by one of two methods: 

1. Unknown coordinates:  Define the coordinates by creating points on the map.  Select the 
right mouse button and select add location at the four vertices of the desired portion of the 
complex shape. Select Apply Filter Group from the menu toolbar to update map (i.e., remove data 
outside of the portion of alignment drawing).  Please note that the user is not required to be exactly 
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on the alignment drawing when adding the vertices point as Veta will find the closest point on the 
alignment drawing from each location added by the user. 

 

 

 

Map prior to Applying Filter Group: 
Four (4) vertices added through location filter. 
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2. Known Coordinates:  Define the coordinates by pasting in the known northing and eastings.  
Select and copy the vertices coordinates (including the northing and easting column headings).  See 
form IC-106 for lot coordinates for the IC Method. 

Select lower left panel of northing and easting table with the right mouse button.  Select Paste 
Locations.  Select Apply Filter Group from the menu toolbar to update map (i.e., remove data 
outside of the portion of alignment drawing).  

Trimmed data after selecting Apply Filter Group 

Coordinates of four vertices. 
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Trimmed data after selecting Apply Filter Group 

Pasted coordinates. 

Map prior to pasting coordinates and 
Applying Filter Group. 
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OVERRIDE FILTERS 
Override filters allow the user to filter the data per Machine ID (e.g., IC Roller, PMTP System).  Veta 
automatically creates override filters for all Machines ID’s with associated data when creating Filter 
Groups using the MnDOT Filter Group Manager.   

 

The following is an example of an override filter for the IC system on the “CW34” roller. 
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DATA FILTER 

IC Method 

The data filter is not currently used for the IC method, but can be used as needed for specialized 
analyses (e.g., reviewing measurements at given temperature ranges, compaction efforts when 
vibration is on vs. off, etc.) by selecting Create from the menu toolbar and then selecting Create 
Data Filter.  The user must ensure that the box is selected next to the given Data Filter in order 
for it to be associated with the given Filter Group. 

PMTP Method 

The data filter allows the user to filter the data by maximum and/or minimum speed and temperature.  
The temperature filter is the only data filter used for the thermal segregation analyses.  Surface 
temperature readings less than 180°F (80°C) are removed from the thermal segregation analysis.  
These lower temperatures are removed to assist the cold edge filter with removal of brackets used for 
pavement smoothness and also to remove surface temperature readings capturing the body 
temperature of individuals checking the mat thickness / straight edge measurements in the PMTP 
system measurement area (see Figure 5.4).  Brackets used for pavement smoothness are often 
measured at temperatures of 150-175°F, and therefore, 180°F is used to remove these measurements.   
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FIGURE 5.4 – Illustration of body temperature measurements captured by PMTP system. 

 

Veta automatically creates and selects the temperature Data Filter when using the MnDOT  
Filter Group Manager for creation of Filter Groups.   

Ensure that the temperature Data Filter is selected to allow this data filter to be associated with all 
Filter Groups.  Additionally, ensure that the minimum temperature is set >=180 by selecting 
Temperature from the Data Filter in the upper left pane and then viewing the minimum 
temperature in the lower left pane. 
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5.1.16 Apply Filter Group 
The apply filter group feature in the menu toolbar allows the user to refresh the map with the currently 
selected filter group or with the modifications made to the data, operation and/or override filters. 

Select Apply filter group from the top menu to refresh the map currently displayed with any filter 
modifications or for a new filter group selection. 

 

Map prior to selecting Apply Filter Group 
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5.1.17 Establishment of Sublots for Each Lot (PMTP Method Only) 
The PMTP method requires the creation of sublots.  This can be done in Veta by using the Sublot 
feature. 

Select Sublots from the menu toolbar.   

 

Select the Filter Group for the desired lot by selecting the dropdown.  Select Apply Filter Group, 
if needed, to update the map. 

 

Select Add from the menu toolbar. 

 

Refreshed map after selecting Apply Filter Group 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 60 | P a g e  

 

A pop-up box with an automatically generated sublot label using the required standardized naming 
convention will appear.   

Select OK and Veta will associate the sublots with given Filter Group.  

The user is required to set the start and stop location for generation of the sublots and to set the sublot 
length to 150-ft for instances where the MnDOT template was not used during creation of the given 
Filter Group. 

 

Ensure that the start and end locations were set correctly by completing the following steps. 

Set Start Location 

Select Zoom To from the command toolbar and then selecting Zoom to first location from the 
dropdown list to find the beginning of paving.  Use the zoom feature to zoom into the image to the 
maximum zoom extents.   
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The user can modify the pin location by placing the mouse curser immediately adjacent, to the mid-
edge of the surface temperature readings.  Right click the mouse and select Set Start Location.   

 

Set Stop Location 

Select Zoom To from the command toolbar and then selecting Zoom to last location from the 
dropdown list to find the end of paving.  Use the zoom feature to zoom into the image to the 
maximum zoom extents.   

 

The user can modify the pin location by placing the mouse curser immediately adjacent, to the mid-
edge of the surface temperature readings.  Right click the mouse and select Set Stop Location.   
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Sublot Length 

Ensure that the longitudinal length of the sublots is set at 150 ft by viewing the bottom, left pane.  Do 
not adjust the northing and easting values.  These were automatically entered through the previous 
steps when selecting the start and end of paving (i.e., start and stop locations). 

 

Create Lots 

Select Create Lots from the top toolbar. 
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Review Created Sublots 

Visually inspect the map to ensure that 150-ft sublots weres created along the entire lot limits. 

 

5.1.18 Spot Tests 
The Spot Tests feature allows the user to overlay verification and/or quality assurance test results (e.g., 
density – cores, density – nuclear gauge, DCP, Sand Cone, etc.) on top of the IC or PMTP data.  
Coordinates of the verification/quality assurance spot test location are required to import the test 
values into Veta.  Ensure that the coordinate system associated with each spot test is the same 
coordinate system as that being used in the Veta project.  Convert the coordinates as needed 
using MnCON (see section 5.2). 

Veta does not currently have a spot test manager, and therefore, spot tests are added independently 
using the toolbars in Veta or by creating a data table in excel prior to batch importing. 

Manual Entering of Spot Test Data 

Select Spot Tests from the menu toolbar.  Select Add from the Spot Test menu. 
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Select the file that the spot test data is associated (e.g., final coverage, pass count 1, pass count 2, raw 
data, etc.). 

 

Enter the spot test ID, date, coordinate information, test type and value into each row of the table. 

 

Batch Importing of Spot Test Data 

Create spot test table in excel.  Ensure that the table column headings in Excel identically match 
those used in Veta (e.g., ID, Date, Easting (ft), Northing (ft), Test Type, Value) and that the text for 
the Test Type identically matches the given test as listed in the dropdown in Veta (e.g., Density – 
Cores). 
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Select Spot Tests from the menu toolbar in Veta.   

Select the file that the spot test data is associated (e.g., final coverage, pass count 1, pass count 2, raw 
data, etc.) 
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Copy spot test table (including headings) in excel by selecting the given cells (hold the left 
mouse button, and while holding the left mouse button, drag the mouse over the desired cells) and 
then selecting CNTRL C.  See yellow shading in previous excel figure. 

Select Paste in the spot test toolbar in Veta.   

 

Examine the black dots on the map.  Mouse over them to view the spot test information. 
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5.1.19 Analysis 
Analysis allows the user to analyze the IC or PMTP data and examine the results for each lot, lift, lane, 
and Machine ID.   

Radius 

The Radius (ft) feature is used when spot tests are added to the project.  This feature allows the user 
to calculate the average value, of the given IC or PMTP measurement, over a circular region with a 
radius size as input by user.  This average value is calculated at the location of each Spot Test 
measurement for use in correlation analyses. 

Analyses for the IC Method 

Select Analysis from the menu toolbar and select the desired Filter Group and then select Apply 
Filter Group. 

 

No additional setup or forms need to be completed in the analyses setup form.  Select Analyze.  If 
Analyze button is grayed out ensure that the Apply Filter Group has been run.  

Observe the results by selecting the menu items on the left from top down. 

 

Coverage (Form IC-108) 

The roller coverage required in form IC-108, for each lot, is found in the Coverage results.  Select 
Coverage from the left panel.  Copy the results by hovering the mouse over the coverage table in the 
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upper right pane and selecting the right mouse button.  Then select copy table without column 
names. 

 

Paste the results into form IC-108 by selecting (with left mouse button) the desired cell in column C 
of excel and pasting the results (CNTRL V). 

Veta adds an additional row of data for the overall results.  Delete this data from the form.   

 

Overall Results 

The Overall Results \ Distribution tab provide a statistical summary of the entire data set associated 
with the Filter Group selected for the analysis.  Select the desired parameter from the left pane to 
view the associated statistics.  Univariate statistics (i.e., mean, standard deviation, coefficient of 
variation (CoV), Variance, minimum, maximum and sample size) are listed in the table to the left of 
the histogram.  The histogram in the right pane reflects the cumulative distribution and the individual 
percent occurrences at given values. 
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The following is an example of the statistical analyses for temperature. 

 

Correlation Results 

The correlation results are presented in the Overall Results \ Correlation tab for the given 
parameter.  Care must be taken when reviewing these results as the results are generated from a simple, 
linear regression.  Multiple variables are often needed when looking at relationships. 

 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 70 | P a g e  

 

Analyses for the PMTP Method 

Select Analysis from the menu toolbar and select the desired Filter Group and then select Apply 
Filter Group. 

 

Additional setup of the analysis setup form is needed for the thermal segregation analysis.  Setup the 
form as follows: 

(2016) Quality Management – Paver Mounted Thermal Profile Method (S-xx.3.J.1)  

1. Select the minimum stop duration (minutes) to 1 minute. 
2. Select (check) Remove paver stop areas from analysis. 
3. Select the Temperature tab and complete the differential specification requirements as follows: 

a. Select (check) the Use differential target in sublots. 
b. Moderate Start (°F):  enter 25 in the text box. 
c. Severe Start (°F):  enter 50 in the text box. 

Select Analyze.  If the Analyze button is grayed out ensure that the Apply Filter Group has 
been run.  
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Observe the results by selecting the menu items on the left from top down. 

 

Thermal Segregation (Form PMTP-102) 

The thermal segregation information required in form PMTP-102, for each lot, is found in the 
Sublot Results\ Temperature \ Differential tab.   

Enter the filter group name and county into form PMTP-102.  As indicated in the image below, the 
number of sublots in the low, moderate and severe categories can be found on the differential tab.  
Enter these values into columns C-E of form PMTP-102.   

The final sublot length is often not equal to 150 linear-ft, and consequently, the monetary price 
adjustment is prorated for this final sublot.  The length and severity level of the final sublot is listed 
in the detailed sublot table as indicated below.  Enter this information into columns G and H of 
form PMTP-102.  The user can either scroll to the bottom of the table or select the drop down 
arrow next to Start Distance (ft) to sort the sublots in descending order to view the final sublot 
length and thermal segregation category for cases where this information cannot be seen due to longer 
listings. 
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Number of sublots in the low, moderate 
and severe thermal segregation category. 

The length and thermal segregation 
of the last sublot. 
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Overall Results 

The Overall Results \ Distribution tab provide a statistical summary of the entire data set associated 
with the Filter Group selected for the analysis.  Select the desired parameter from the left pane to 
view the associated statistics.  Univariate statistics (i.e., mean, standard deviation, coefficient of 
variation (CoV), variance, minimum, maximum and standard deviation) are listed in the table to the 
left of the histogram.  The histogram in the right pane reflects the cumulative distribution and the 
individual percent occurrences at given values. 

The following is an example of the statistical analyses for temperature. 

 

Correlation Results 

The correlation results are presented in the Overall Results \ Correlation tab for the given 
parameter.  Care must be taken when reviewing these results as the results are generated from a simple, 
linear regression.  Multiple variables are often needed when looking at relationships. 
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5.2 MnCon 
MnCon is a coordinate conversion program that performs conversions within or across the North 
American Datums of 1927 and 1983.  It converts between any two of the 232 different map 
projections including:  NAD27 and NAD83 latitude/longitude, NAD27 and NAD83 universal 
transverse Mercator zone 15 extended, the three Minnesota state plane zones in both NAD27 and 
NAD83, 68 NAD83 Minnesota county coordinate system zones (including one covering all of St 
Louis County) and 159 NAD27 project zones. 

For use with Veta, this software can be used to convert the coordinates for spot tests that were 
collected in a coordinate system different from that used in the given Veta project. 

5.2.1 Software Download 
Open the following link to access the MnDOT Software applications and technical resources site. 

http://www.dot.state.mn.us/surveying/toolstech/index.html 
Accept the conditions and select Office of Land Management Software to be directed to the site 
where the MnCon software can be downloaded. 

http://www.dot.state.mn.us/surveying/toolstech/index.html
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Scroll down the webpage to find the MnCon software.  Select DOWNLOAD under the MnCon 
description. 
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Select either Run or Save MnCon_Install_413.exe. 

 
Follow the prompts to extract and install the software. 
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Navigate to the desktop (or folder) where the extracted files are located and find the MnSETUP.exe.  
Double click this file to open and execute. 

 
Review the terms of the disclaimer and select “I accept the terms of the disclaimer” if in agreeance.  
Next select Continue. 

 
Use the default Installation Path.  It is recommended that “Install a Desktop Shortcut for 
MnCon” is selected (checked).  Select Install. 
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The following prompt will show upon completion of the installation.  Select OK. 

 

5.2.2 Open MnCon Software 
Double click on the desktop icon, or navigate to the location chosen for the installation path, to 
open the MnCon software. 

 
This will open the Minnesota Coordinate Conversion Program (see image below). 
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5.2.3 Convert From – Source 

SOURCE MAP PROJECTION 
Select the projection box in the left panel for Convert From – Source and then select the 
projection used for the spot test coordinates.  Select OK. 
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UNITS OF ELEVATIONS ONLY 
Select the Units of Elevations (US Survey Feet or Meters). 

 

LAT / LON 
Select the format of the coordinates when collected in the Latitude / Longitude projection (Deg Min 
Sec, Decimal Deg, or Deg Min). 
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SOURCE COORDINATE VALUES 
The source of the coordinate values reflects the format that the source coordinates will be input into 
MnCon. 

Select the Input From dropdown and select the format of the source coordinates. Browse to file 
location and select open to import file.  

 

5.2.4 Convert To – Target 

TARGET MAP PROJECTION 
Select the projection box in the right panel for Convert To – Target and then select the projection 
used in the given Veta project (i.e., county coordinate projection).  Select OK. 
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UNITS OF ALL COORDINATES 
Select the Units of All Coordinates (US Survey Feet or Meters). 

 

ROUND TARGET COORDINATE VALUES 
It is recommended that the coordinates are rounded to at least 0.001 units for conversion of spot test 
coordinates.  Other applications, may require a higher accuracy. 

Select the Round Target Coordinate Values dropdown and select the desired rounding.  
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TARGET COORDINATE VALUES 
Select the Output To dropdown and select the desired format of the exported file.  It is 
recommended that Comma Delimited File is used for spot test coordinates.   

 

Browse to desired file location to store output file.  Enter name for the file to be stored as. 

 

5.2.5 Report Options 

REPORT FILE 
Select Overwrite (unless the user wants to track the report files).  The user can leave the Report file 
location as the default location, or browse to the desired file storage location. 
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DESCRIPTION FOR REPORT FILE HEADER 
It is recommended that the original and final projection of the coordinates is included in the 
description for the Report File Header. 

 

ADJUSTMENT 
Select the 1996 adjustment as MnDOT designs use this adjustment. 

 

5.2.6 Convert 
Select Convert. 

 

USER-DEFINED DELIMITED FORMAT FOR OUTPUT FILE 
A popup window will appear after selection of convert.  Select the Format Name dropdown and 
select the source projection (e.g., MnCon Standard).  This will then populate the Current Format 
Specification text box.  Select Accept and Continue if this is the correct format of your imported 
file.   

Repeat this same process for the Ouput File.  Ensure that county coordinates are selected for the 
target projection. 
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ADD “NEW” USER DEFINED INPUT FILE FORMAT 
Select Add to add a new file format when the fields (or order of the fields) in the default format 
do not match those of the import file.  Ensure that the fields are added in the same order as listed in 
the import file. 
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COMPLETION OF COORDINATE CONVERSIONS 
After completion of the user defined formats a viewer will open which displays the coordinate 
conversions.  The file was also stored to the location selected in the report options. 
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5.3 TRIMBLE CONNECT 
Trimble Connect is a tool used to improve project collaboration that can be accessed by Desktop, 
Mobile and/or Web to view, share and access project information.  Trimble Connect is the file sharing 
platform that the Department is using during the 2017 Calendar Year for the sharing of files associated 
with the intelligent compaction (IC) and Paver Mounted Thermal Profiling Technology (PMTP) 
between the Engineer and Contractor.  For more information related to Trimble Connect go to:  
http://connect.trimble.com/ . 

5.3.1 Trimble Connect User Account 
The Department (the Advanced Materials and Technology Unit [AMT]) will create the given project 
in Trimble Connect and create the Team of individuals that can access this project.  To add users, 
the following information (in tabular format) must be provided to the AMT unit for both the 
Department and Contractor staff requiring access to Trimble Connect: 

Project Number(s) 
(e.g., SP) 

Route Number(s) 
(e.g., TH 17) 

First and Last Name  
of User E-Mail of User 

 

An automated e-mail is sent to each user after being added as a Team member to the project.  This 
e-mail message will provide a link to the project.  The following image is an example of one of these 
automated e-mails. 

 

5.3.2 Create New Trimble ID 
Creation of a user account is required for first time users.   

Go to the Trimble connect Website:  http://connect.trimble.com/ .  Select Sign In from the top 
right corner of the website. Or, select View Project from the automated e-mail received when being 
added as a Team member for the given project. 

http://connect.trimble.com/
http://connect.trimble.com/
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Select Create New Trimble ID or Sign in with Google. 

 

Complete the required account information and then select Create New Account. 

 

An automated e-mail (Subject line will include:  Trimble Account Creation Notification) is sent 
to the user for activation of this account.  The following image is an example of one of these automated 
e-mails.  Select Activate Account. 
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The user is redirected to the following screen after selection of Activate Account.  Select Here to 
login to Trimble Connect. 

 

5.3.3 Sign In (Login) to Trimble Connect 
Go to the Trimble connect Website:  http://connect.trimble.com/ .  Select Sign In from the top 
right corner of the website. 

 

Enter the user Email address and password into the form and select Sign In. 

http://connect.trimble.com/
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5.3.4 Logout of Account 

Select the account icon on the top right menu and then select Sign Out from the dropdown 
menu to logout of the Trimble Connect Account. 

 

 

5.3.6 Profile (Edit Time Zone) 

Ensure that the correct time zone (Central Time [US & Canada]) is set as the profile preferred time 
zone.  Select the account icon on the top right menu and then select Profile from the dropdown 
menu. 

 

Scroll down the profile information to the Timezone Preference section.  Select the displayed time 
zone if an incorrect time zone is displayed.   
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Select the correct time zone using the provided dropdown list. 

 

Select the check box to accept and save changes, or select the X to cancel changes. 

 

5.3.5 Projects Menu 

A listing of projects that the user has been added to as a team member are displayed on the projects 
screen. 
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PROJECT LISTING VIEWS 
The command menu allows the user to view the project listing in either a tile or list format. 

View of Project Listing in Tile Format 

       

 

View of Project Listing in List Format 

 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 95 | P a g e  

 

 

OPEN PROJECT 
Select the project with the left mouse button to open it.  The internet window will then redirect the 
user to the information contained within this project.  The project currently being viewed is listed in 
the top left corner of the platform immediately below the Trimble Connect icon. 

 

5.3.4 Exit Project 
Select the Trimble Connect icon in the top left corner of the platform to exit out of the given 
project and to go back to the project listing. 
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5.3.5 Data Menu 
The data menu lists all of the project files with respect to the given folders and subfolders.   

FOLDERS 
Select the triangle to the left of the folder name to expand the given folder and view the 
corresponding subfolders.  Select the desired folder in the left or right pane to open.   

 

UPLOAD FILE(S) 
Select the desired folder to upload and store given files.  Select the Upload Files icon to start the 
upload process. 

 

Select Browse in the popup window to search for the file(s) to be uploaded to Trimble Connect.  
Select the desired file(s). 
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A popup window will appear providing a summary of the upload status.  Click close if no further 
files need to be uploaded to this folder.  Please note that files can be moved to other folders by 
selecting the file with the left mouse button and dragging it into the desired folder. 

 

FILE PROPERTIES 
Select (check) the file to view given file property information.   
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The menu bar in the right pane (after selection of a given file) allows the user to view the following 
properties: 

 

Details – File Name, Creator, File Date, File Size, Modification Information and the ability to add 
Tags for use with the search engine. 

 

Activity – Provides a listing of the history of actions associated with the given file. 

 

Comments – The user can add any needed comments to the available test box and then select Add 
Comment to save. 
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Revisions – All versions of the file are saved in Trimble Connect.  The user can view and download 
the various versions at any time by either selecting the file or selecting the download icon. 

 

EDIT FILE NAME 
File names can be modified after uploading the files. 

Select the file to be modified.  Select the Details menu in the right pane and then select the file 
name in the details pane. 

 

Place cursor in the text box (click the left mouse button while hovering over the text box) and edit 
the file name accordingly.  Select the check box to save changes.  Select the X to cancel changes. 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 100 | P a g e  

 

 

DOWNLOAD FILE 
Select the file to download.  Select the Download icon to begin download process.  A message 
will appear below the download icon to indicate the process has started.   

 

Select save as from the dropdown menu and browse to the desired file storage location and then 
select save. 
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SHARE FILE 
Share allows the user to notify other users that a new file was added to the Trimble Connect project.  
Select the file to share.  Select the Share icon to share the file with another user.  A popup window 
will appear.  Type in the name of the desired recipients.  The names should populate below as the 
user is typing.  Select the name auto-populated in the list.  Add additional recipients as needed.  
Select Send. 

 

 

Delete a name from the recipient list by selecting the X next to the given name. 
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DELETE FILE 
Select the file to delete.  Select the Delete icon.  A popup window will appear to confirm whether 
or not the file is deleted. 

 

VIEW 
The view icon will allow the user to view given file types within Trimble Connect.  The Trimble team 
plans to add additional file formats into this viewer over time.  Please note that Veta projects cannot 
be viewed directly in Trimble Connect. 
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MORE 
The More icon allows the user to complete additional actions, such as checking in and out files, etc. 

 

 

CLEAR SELECTION 
Select clear selection at any time to deselect all file(s) that have been selected. 
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5.4 TRIMBLE ROVER – FEATURE CODE LIBRARY 
The intelligent compaction technology requires the Engineer to collect the four boundary coordinates 
for each lot as defined by the special provision.  A feature code library has been created to assist with 
the required standardized naming convention used to establish lots.  Additionally, this library contains 
attributes for the standardized naming of quality assurance / quality control test locations (e.g., core 
densities, nuclear gauge, etc.). 

5.4.1 Download of Feature Code Library 
The feature code library is available for download from the Advanced Materials and Technology 
website at:  http://www.dot.state.mn.us/materials/amt/forms.html.  

5.4.2 Installation of Feature Code Library (Tablet) 
Copy the downloaded feature code library to a removable media device (i.e., USB thumb drive). 

Open Trimble Access on the tablet and select the Files icon.  A Windows Explorer Window will 
then open. 

 

Navigate to the Removable Disk to locate the Feature Code Library File.  Tap and hold on the 
file for a short period and select copy from the popup menu. 

http://www.dot.state.mn.us/materials/amt/forms.html
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Navigate to Trimble Data > System Files.  Tap and hold on the screen for a short period of time 
and select paste from the popup menu.  Exit Windows Explorer by selecting the “×” in the top 
right corner after pasting the feature code library into the System Files folder. 
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5.4.3 Setup Job Properties 
The user can modify the coordinate system used, units of measure and add the feature code library to 
a desired job through Trimble Access.  Open Trimble Access on the tablet and select the General 
Survey icon. 

 

Select the Jobs icon from the General Survey panel. 

 

Select Properties of Job from the Jobs panel. 
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Units 

Select Units from the Properties of Job panel.   

 

Update the units to English units using the dropdown menus.  See images below for the final settings 
in Units panels 1 and 2. 
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Coordinate System 

Select Coord. Sys. from the Properties of Job panel. 
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Select “Select from Library” from the Coordinate System panel. 

 

Select United States/Counties/MN from the System dropdown menu. 

Select the desired County from the Zone dropdown menu. 

Check box for Use Geoid Model.  Select the geoid model from the dropdown menu. 

Enter the project height. 
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Attaching Feature Code Library to Job 

Select Feature Library, from the Properties of Job panel, to add desired library to this job. 

 

Select the Feature Library to be added to this job.  Select Accept. 
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The recently added feature code library will now appear in the properties panel.   

 

Select Yes to overwrite the existing job with these changes. 
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5.4.4 Storing Measurements Using Feature Code Library 
Open Trimble Access on the tablet and select the General Survey icon. 

 

Select the Measure icon from the General Survey panel. 

 

Select RTK from the Measure panel. 
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Select Measure Points from the RTK panel. 

 

Enter the Point Name and Antenna Height.  Select Options at the bottom of the panel. 
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Check Auto Store Point on the options panel.  Select Accept. 

 

 
Select the dropdown menu for Code from the Measurement Points panel.   
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Select the desired Attributes library and then select Enter.  See subsections below for 
descriptions of each attribute library. 

 

Select Attrib from the bottom menu options.   
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Complete the attributes library accordingly.  Select Store to save the completed information. 

 

Select Measure to capture the coordinates for the given location.  Repeat this process for the 
collection of additional points using this library (1.  Update Point Name; 2. Select Attrib to enter the 
information for the next point; 3. Select Store to save information; 4. Select Measure to capture 
coordinates).  Reminder:  Select Code to use a different attributes library. 

Select Esc to exit the Measurement Points panel. 
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BOUNDARIES ATTRIBUTE LIBRARY 
This attributes library is used when collecting the four coordinates for a given lot boundary.   

Additional details related to the boundary and lot corners attributes are discussed below.  See (2016) 
Quality Management Special – Intelligent Compaction Method (Table 2016-7 [IC])) for additional 
details regarding the other attributes used in this library.   

 

Boundary Attribute 

The dropdown for the Boundary lists Lot and Corrective Action.  Select Lot when capturing the 4 
boundary coordinates for establishment of the lot.  Collection of these coordinates are required with 
the IC method.  Select Boundary when capturing the boundary coordinates of an area requiring 
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corrective action.  Collection of these coordinates is optional with the IC method.  This information is 
used for specification refinements. 

Lot Corners 

The diagram below illustrates the locations of the lot corners (B1, B2, E1, E2).  Please note, that the 
“B” designation needs to be at the start of paving and the “E” designation at the end of paving.  The 
subsequent numbers of 1 or 2 can be interchanged as being either the left or right edge of the 
compaction area requiring the technology (e.g., B1 can be used for the edge of pavement and B2 as 
the centerline location). 

 

DENSITY – CORE ATTRIBUTE LIBRARY 
This attributes library is used when measuring the location of cores used for density measurements.  
Ensure that the Lot/Core Number and Core Sub Number match the core number for the core taken 
from the given location (e.g., 1.1, 1.2C, etc.). 
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(SPOT TEST) SPT ATTRIBUTE LIBRARY 
This attributes library is used when measuring the location of all other quality assurance / quality 
control test locations (i.e., test types other than core densities [e.g., nuclear gauge, light weight 
deflectometer, moisture, etc.]).  Ensure that the Test Number matches that used for the spot test on 
the given testing form. 

 

5.4.5 Exporting Coordinates 
Open Trimble Access on the tablet and select the General Survey icon. 



  Advanced Materials and Technology Manual | March 14, 2017 
  Chapter 5 – Software Programs 

 121 | P a g e  

 

 

Select the Job icon from the General Survey panel. 

 

Select Import / Export from the Job panel. 
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Select Export Custom Format from the Import/Export panel. 

 

Select the following information in the Export Custom Format panel: 

(1) CSV with Attributes 

(2) Browse to location to store file and enter File Name.  Include SP number, route number 
and export date (in MMDDYY format) in the file name (e.g., SP1234-56 TH78 071217). 

(3) Uncheck View Created File unless using Trimble Access 2016. 

(4) Select Yes from the Include Attribute Names dropdown menu.  The attribute names are 
needed for the import feature in forms IC-105, IC-106 and IC-107 to work correctly. 
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A popup window will appear indicating the completion of the file transfer.  Select Exit to leave 
Export panel.   

 

Select Accept.  Transfer file to a removable media device (i.e., USB thumb drive) and import 
coordinates into forms IC-105, IC-106 and/or IC-107.  Please note that by default, the files are stored 
in the Trimble Data>Username>Export folder if a given directory was not browsed to and selected 
during creation of the export file. 
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